Using World Wide Web via Netscape
-A Short Guide for PEP-II/BABAR *

Andrea Chan, Jeremy Nelson

Stanford Linear Accelerator Center
Stanford University
Stanford, CA

* Work supported by the Department of Energy contract DE-AC03-76SF00515
# Table of Contents

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>What is the Internet, Mosaic and Netscape</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Using URL's</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Netscape menus and buttons—what they do</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>Using Bookmarks</td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>FTP through Netscape</td>
<td>9</td>
</tr>
<tr>
<td>6</td>
<td>FTP through Fetch on the Macintosh</td>
<td>12</td>
</tr>
<tr>
<td>7</td>
<td>Installation Netscape</td>
<td>14</td>
</tr>
<tr>
<td>8</td>
<td>Configuring Netscape</td>
<td>16</td>
</tr>
<tr>
<td>11</td>
<td>References</td>
<td>20</td>
</tr>
</tbody>
</table>
What is the Internet?

The Internet is a collection of information stored in computers physically located throughout the world. It connects more than 3.2 million mainframes to each other, but each one has its own job to do. The World Wide Web (WWW) was created by particle physicists working at CERN, and was a system of storing information in a format that had the addresses of other sites with similar information saved with it. Through WWW, much of the information on the Internet is organized onto pages. You'll bring one page to your computer screen, discover its contents, and have the option of going to more pages of information.

NCSA Mosaic

A bunch of computer science students and the University of Illinois' National Center for Supercomputing created a program called Mosaic. Mosaic took Web files, complete with links, and displayed them in a graphical window. Links are underlined text, called hypertext, that takes you to another page. Mosaic emphasized the actual information, but not the source.

Taking a Step Further — the Netscape Navigator

Netscape picks up where NCSA Mosaic left off. It installs easily, works well over a conventional modem connection, and is supported by a professional software company. Bugs get fixed and features get added in response to customers (instead of NCSA's method of updates which responded to academic pressures). It uses most standard Internet services and mimics many of the UNIX-based text programs that most people find confusing.

Netscape truly integrates the hypertext-based WWW with the older, conventional Internet formats that haven't yet been or will never be, converted to the Web's HTML (HyperText Markup Language) format. Netscape knows what to expect from older Internet services and assigns some hypertext links within them automatically.

Caution:

Although Netscape provides some security for information it reads and sends out, the security is still very limited. For example, Netscape will allow you to bring up a form to send e-mail to Internet e-mail addresses. But there is no verification of the sender's e-mail address. The sender can type in any e-mail address. Similarly, there are problems with sending and viewing secure information on WWW.
Uniform Resource Locator (URL)

To find a single WWW page in a world of electronic pages, you need to know its URL, short for Uniform Resource Locator. Every page has a unique URL just like every person has a unique palm print. (Arguments persist as to which is more cryptic.)

Netscape gives you two options of typing in the URL:

1) type a URL directly into the location text field

![Netscape: PEP-II/BABAR Database Information](image1)

Location: http://www.slac.stanford.edu/accel/pepii/db.html

2) or pull down File menu to Open Location.
   type desired URL in the Open Location dialog box

![Open Location](image2)

Open Location: http://www.slac.stanford.edu/accel/pepii/db.html

[Cancel] [Open]
How to read a Uniform Resource Locator (URL)

http://llama.ucsd.edu/pub/webfiles/index.html

1. First is the protocol (language) that the site uses.
2. Next is the location or host name of the computer that stores the resource.
3. Now you indicate the directory structure where the resource is located.
4. Finally, here's the name of the Web page or name of the file that links the resource.

For example, to use the Gopher menus at pccatalog.peed.com:

gopher://pccatalog.peed.com

To enter the anonymous FTP site at wuarchive.wustl.edu:

ftp://wuarchive.wustl.edu

Protocol abbreviations

<table>
<thead>
<tr>
<th>Protocol</th>
<th>What's it for?</th>
</tr>
</thead>
<tbody>
<tr>
<td>http://</td>
<td>Hypertext Transfer Protocol—linking Web pages</td>
</tr>
<tr>
<td>ftp://</td>
<td>File Transfer Protocol—accessing anonymous FTP sites, and Web pages at older sites</td>
</tr>
<tr>
<td>gopher://</td>
<td>Gopher protocol—accessing Gopher menus</td>
</tr>
<tr>
<td>telnet://</td>
<td>Starts a Telnet session and opens a Telnet window to run older, text-based Internet programs</td>
</tr>
<tr>
<td>mailto:</td>
<td>Opens Netscape's Send Mail dialog box to send e-mail</td>
</tr>
<tr>
<td>news:</td>
<td>Opens a UseNet newsgroup to link posted articles</td>
</tr>
</tbody>
</table>

Domain abbreviations

<table>
<thead>
<tr>
<th>edu</th>
<th>Educational institutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>com</td>
<td>Commercial businesses</td>
</tr>
<tr>
<td>gov</td>
<td>The U.S. government</td>
</tr>
<tr>
<td>mil</td>
<td>The U.S. military</td>
</tr>
<tr>
<td>net</td>
<td>Network or Internet Service Providers</td>
</tr>
<tr>
<td>org</td>
<td>Other organizations</td>
</tr>
</tbody>
</table>

Figure from 'Using Netscape' by Warren Ernst, QUE Corporation.
Frequently-used URL's for PEP-II and BABAR

PEP-II/BABAR Project Database

http://www.slac.stanford.edu/accel/pepii/db.html

PEP-II Accelerator Home Page

http://www.slac.stanford.edu/accel/pepii/home.html

FTP PEP-II-Server

ftp://pepii-server.slac.stanford.edu/

SLAC BABAR Detector Home Page


SLAC Home Page

http://www.slac.stanford.edu/FIND/slac.html

Stanford University Libraries & Academic Information Resources Home Page

http://www-sul.stanford.edu:8000/

Stanford University User Server

http://www-leland.stanford.edu/

Welcome to Netscape

http://home.mcom.com/home/welcome.html

The Netscape Online Handbook

http://home.netscape.com/eng/mozilla/1.1/handbook/
Netscape Commands

In addition to hypertext links in the content area of the page, you can also access links using Netscape buttons and menu items. Many of the links controlled by buttons and menu items bring pages you have viewed at least once before. Button links are particularly useful for going back and forth among recently viewed pages.

Menu item links directly access a wide range of pages such as a history list of pages you have viewed or a bookmark list of pages you (or others) have personally selected as noteworthy. Here is a list of useful Netscape commands and their actions:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks</td>
<td>Add Bookmark</td>
<td>Mark a site so you can visit it later</td>
</tr>
<tr>
<td>Directory</td>
<td>Go to Newsgroups</td>
<td>Join a newsgroup or review newsgroup articles</td>
</tr>
<tr>
<td>File</td>
<td>Exit</td>
<td>Exit Netscape</td>
</tr>
<tr>
<td>File</td>
<td>Mail Document</td>
<td>Create e-mail (see page 1)</td>
</tr>
<tr>
<td>File</td>
<td>Open File</td>
<td>Load a saved Web page from disk</td>
</tr>
<tr>
<td>File</td>
<td>Print</td>
<td>Print the current page</td>
</tr>
<tr>
<td>File</td>
<td>Save As</td>
<td>Save the current page to disk</td>
</tr>
<tr>
<td>Go</td>
<td>View History</td>
<td>See the list of places where you've been this session</td>
</tr>
<tr>
<td>Options</td>
<td>Auto Load Images</td>
<td>Turn graphics off/on</td>
</tr>
<tr>
<td>Options</td>
<td>Preferences</td>
<td>Configure Netscape (see page 16)</td>
</tr>
<tr>
<td>Options</td>
<td>Show Directory Buttons</td>
<td>Turn directory buttons off/on</td>
</tr>
<tr>
<td>Options</td>
<td>Show Security Colorbar</td>
<td>Turn security colorbars off/on</td>
</tr>
<tr>
<td>Options</td>
<td>Show Toolbar</td>
<td>Turn the toolbar off/on</td>
</tr>
<tr>
<td>View</td>
<td>Source</td>
<td>View the HTML file for the current page</td>
</tr>
</tbody>
</table>
Buttons

What do the buttons do?

- Back goes back to the previous Web page.
- Forward displays the next Web page in the history list.
- Home displays your home page.
- Reload reloads and redisplay the current page.
- Images displays inline images with the current page (if they don't automatically load into view).
- Open manually retrieves a new Web page and displays it (you have to type an address).
- Find searches for a word or phrase within the current Web page.
- Stop halts the transfer of Web pages from the Internet into the content area.

How can I save more screen space?

You can save more space by hiding your toolbar, directory buttons, and/or the location text field.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Show toolbar</td>
<td>Show/hide toolbar</td>
</tr>
<tr>
<td></td>
<td>Show Directory Buttons</td>
<td>Show/hide buttons</td>
</tr>
<tr>
<td></td>
<td>Show Location</td>
<td>Show/hide location</td>
</tr>
</tbody>
</table>
How can I customize the buttons?

You can change the appearance of the buttons at the top of the screen. Make them have just pictures, just text or both. See figure below to save more screen space.

Pictures & Text

- File  Edit  View  Go  Bookmarks  Options  Directory  Help
- Back  Forward  Home  Reload  Images  Open  Print  Find  Stop

Pictures

- File  Edit  View  Go  Bookmarks  Options  Directory  Help
- Back  Forward  Home  Reload  Images  Open  Print  Find  Stop

Text

- File  Edit  View  Go  Bookmarks  Options  Directory  Help
- Back  Forward  Home  Reload  Images  Open  Print  Find  Stop

Here is how to customize buttons:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Preference (under Window and Link Styles)</td>
<td>change appearance of the buttons</td>
</tr>
</tbody>
</table>

Copy text from Web pages to your Clipboard

Netscape allows you to Select and Copy text right off the Web page:

1) Move the mouse pointer to the beginning of the text you wish to copy and select the text.

2) Choose Copy from the Edit menu to copy the text, then Paste into your document.
**Bookmarks**

You can save a page with Netscape's bookmark command just as you can save a page in a book with a regular bookmark.

**To add a bookmark:**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks</td>
<td>Add Bookmark</td>
<td>Adds your favorite pages to the bottom of the Bookmarks menu</td>
</tr>
</tbody>
</table>

Netscape makes jumping to a page marked with a bookmark easy. There are two methods of viewing a bookmarked page:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Selection</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks</td>
<td>pull down to desired bookmark</td>
<td>brings up bookmarked page</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>View Bookmarks (select desired bookmark then click Go to)</td>
<td>brings up bookmarked page</td>
</tr>
</tbody>
</table>

Accessing a page from the Bookmarks Menu is generally more convenient, but it can only display as many bookmarks as you have screen space.

The Bookmark List dialog box, (brought up by View Bookmarks on the Bookmark Menu) has a scrollable and searchable list that provides access to hundreds of bookmarks at once, and it even provides a Find command to find that hard-to-spot bookmark in a large list (See figure on next page).
Figure of Bookmark List Dialog Box

Some buttons on the Bookmark List dialog box

Go To--With desired bookmark highlighted click this button to jump to bookmarked page

Remove Item--Removes highlighted bookmark

New Divider--Puts a dividing line in your bookmark List dialog box, you can move the divider with the arrow buttons

New Header--Type in a heading to separate different bookmarks, you can move the heading with the arrow buttons

Export--Saves your list of bookmarks to your hard drive or to a disk

Import--Imports Netscape Bookmark lists, as well as Mosaic Hotlists
File Transfer Protocol (FTP)

PEP-II/BABAR shared files & drawings, together with general information and software for your computer is available for you to copy from the Internet via FTP. a File Transfer Protocol. Netscape transforms anonymous FTP into a simple way to get a copy of the files you want from a server to your desktop computer.

How to use Anonymous FTP with Netscape

1) Choose Open Location from the File menu or click in the location field.

2) Add "ftp://" to the beginning and a "/" at the end of the FTP site's address (which creates the URL: ftp://pep2-server.slac.stanford.edu/ in the example below). Click the Open button or press the Enter key.

Welcome to PEP2-SERVER.SLAC.STANFORD.EDU

You are either logged in as user ftp or anonymous.

This FTP server currently allows 10 simultaneous FTP sessions. Problems with your FTP session to this machine should be reported to johnw@slac.stanford.edu immediately.

Read access is allowed on disk2.

BaBar Server/ Sat May 6 20:33:00 1995 Directory
Backups/ Wed Apr 5 15:54:00 1995 Directory
Injection/ Mon Sep 26 14:52:00 1994 Directory
Lattice/ Sat Jun 10 12:14:00 1995 Directory
MagBackup/ Sun Jun 18 16:58:00 1995 Directory
MeetingMaker® XP/... Wed May 24 17:05:00 1995 Directory
PEP-II Server/ Sat May 6 20:33:00 1995 Directory
Icon Indicates Action

- Subdirectory: Jumps to a new subdirectory.

- Document: Transfers an HTML, text, or PostScript file to your computer via FTP.

- File: Transfers a generic file to your computer via FTP. These are frequently compressed computer programs, and if Netscape can determine the type of file it is, it will list it along with other file information in the content area.

- Executable: Transfers an uncompressed program that will probably run on your computer without modification via FTP.

To Navigate through an FTP Site:

- To jump down a directory level to a subdirectory, click on the folder icon or the hypertext.

- To jump up a directory level, click on the hypertext that reads Up to higher level directory.

To Download a File from an FTP Site:
(For Macintosh users, FTP downloads with Fetch is preferred, see page 12)

1) To download a file, click on the file's icon or the hypertext filename

Caution: Big files (> a few hundred kb) take a long time to be transferred across the network and appear on your screen. Please be aware of the size of the file you are viewing or downloading. Click on the Stop button if you want to stop the transfer.

2) To start the file transfer, click Save As in the File menu. Netscape will ask you to specify a new filename.

If the file type of the file you are downloading is not among those which automatically run a helper application, Netscape displays dialog box saying 'This application has not been configured to handle documents of this type'.

- You can configure Netscape to run a helper application on this file by clicking on the Pick application button to specify the program.

- Click Cancel Transfer if you want to stop the transfer.

For Macintosh users—

- If you click on the Save document button. The file is then saved onto the hard disk without an icon identifying what program created it. You will have to open the file from within the application.

For Macintosh users who have Stuffit Expander installed, Netscape will send the compressed Mac file to Stuffit Expander to uncompress and save it on the hard disk (see page 16).
Types of Files (Compressed, etc.)

FTP files are mostly 3 types:

- text files
  these are uncompressed and ready to read

- uncompressed program files that are ready to run
  These programs are often self-extracting compressed files, just double click on them.

- compressed files (including programs)
  Each computer platform may have its own compression program, so you will have to
download the compressed file that your platform has the uncompress program for.
  - Macintosh files are mostly compressed with Stuffit Expander
    with a .Sit or .HQX extension.
    MacGzqip program claims to do gzip UNIX compression and decompression of files.
  - Windows files are mostly compressed with PKZIP with a .ZIP extension.
    Use the program PKUNZIP to uncompress the files.
  - UNIX files are mostly compressed with the compress program with .Z extension or
    the pack program with a similar .z extension.
    Uncompress with the uncompress or unpack commands.

Caution: The only way to get a computer virus from using the Internet is by running an infected
computer program. In transferring programs (not simple text files) via FTP, it is best to run the
virus checker on all programs after you decompress it, and before you run it.

How Netscape does FTP
The Netscape Navigator automatically communicates in the FTP protocol, so when it encounters an
anonymous FTP site, it knows how to connect, log in anonymously, read the contents of the site,
make requests for files, and transfer them. While Mosaic cannot do this, all Netscape needs
from you are a couple of mouse clicks to get things going.

What is a protocol?
FTP refers to both a program and the protocol the FTP program uses to communicate from one
computer to another. A Protocol is a language that a program uses to communicate to another
copy of itself running elsewhere. Example: The Netscape Navigator and the source of a Web page
communicate to each other using the protocol http, the hypertext transport protocol. Similarly,
Netscape communicates like an FTP program to other FTP programs using the FTP protocol.

Anonymous FTP
Collections of files are stored in electronic libraries called anonymous FTP sites, and it's from
these 'file libraries' that Netscape can 'check out' copies of files. Anonymous FTP lets any user
'anonymously' hop into an FTP site without a specific login name of password, and take copies of
whatever files are there. (Actually, the login name is 'anonymous' and the password is your e-
mail address, but programs like the Netscape Navigator take care of these automatically.) The
mainframe is secure from intruders because anonymous FTP does not allow users with the
"anonymous" login to delete or add files.
FTP with Fetch
—the preferred method for bigger files with the Macintosh

The program, Fetch, is much better suited for transferring files via FTP with the Macintosh. It can be used for
1) anonymous FTP
2) FTP using accounts and passwords
   — this allows writing files onto the server using an account with write privileges.

Installing Fetch

For SLAC Macintosh users the Fetch program is available over AppleShare:
   — from the Chooser, go to AppleTalk, zone Mac Servers,
   — get Public Server, Public Disk 1,
   — folder Things You Need, folder Internet Tools, folder Fetch

For non-SLAC Macintosh users, Fetch should be on the Public Disk for your sites. If not, it is available on server pepii-server.slac.stanford.edu.

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems.

Using Fetch

To do anonymous FTP with Fetch, type in the dialog window when you start up Fetch:

   Host: pepii-server.slac.stanford.edu
   User ID: anonymous
   Password: (you can leave blank or type in your e-mail address)
   Directory: (you can leave blank to start from root directory of the server)

Double click on the folder icons to navigate up and down the directories or use the Directory option under menu Directory.

Selected the file you want to FTP

Choose file type Automatic for most files.
Choose file type Text if you are transferring simple text files,
Choose file type MacBinary if you are transferring files created by Macintosh programs (Word, Excel, etc.). These files will be transferred by Fetch with their proper Macintosh icons.

Click on the button Get File and save the file onto your hard disk.
Logging into anonymous FTP with Fetch

- Navigating the server file directories with Fetch.
- Use the Get File button retrieves files from the server to your Macintosh.
- Use the Put File button to write files from your Macintosh to the server (needs password).
Installing Netscape

For SLAC Macintosh Users

The Netscape program is available over AppleShare:
- from the Chooser, go to AppleTalk, zone Mac Servers,
  - get Public Server, Public Disk 1,
  - folder Internet Tools, folder WWW Browsers, folder Netscape
  - copy the Netscape folder onto your hard disk
  - double click on the Netscape Installer
  - after you have successfully installed Netscape, erase the Netscape Installer
    (as well as old copies of the Netscape program you may have)
  - read the documentation in the Netscape folder to configure Netscape

For more information, please read the ‘Netscape Installation & Config’ document on the SLAC Public Disk.

For Non-SLAC Macintosh Users

Please check with your Macintosh Administrators to access the Netscape Installer at your site, or some other Web Browsers like Mosaic or MacWeb.

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems.

For Home Access via the Macintosh

You need the following list of software installed on your home Macintosh:

1) Netscape
2) MacTCP (version 2.0.4 or later)
3) AppleShare (version compatible with MacTCP 2.0.4)
4) Apple Remote Access

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems.

Additional Software for the Macintosh

The standard decompression program is Stuffit Expander (for SLAC users this is available on the Public Disk, for non-SLAC users please check with your Macintosh Administrators).

MacGzip program is available on the Public Disk for SLAC users.

MacGhostScript program is also available for a postscript viewer on the Macintosh (please e-mail ACHAN@SLAC.Stanford.EDU if you would like to test this program).

For more information, please read the ‘Netscape Installation & Config’ document on the SLAC Public Disk.
For IBM-PC Users

Please check with your IBM-PC Administrators to access the Netscape Installer at your site, or some other Web Browsers like Mosaic. The 32 bit version of Netscape is for Windows95 or Windows NT, the 16 bit version of Netscape is for earlier Windows versions.

For IBM-PC’s, the standard compression and decompression program is PKZIP.

Please e-mail ACHAN@SLAC.Stanford.EDU if you have problems.

For UNIX Users

If Netscape is already installed, type netscape at the UNIX prompt or from an XTerm window to start Netscape.
Configuring Netscape

This section is oriented towards the Macintosh version of Netscape. The IBM-PC version will have some similarities.

**Preference Dialog Box**

From the Options menu, choose Preferences.

The Preference Dialog Box will show up. Netscape is configured from this dialog box. We outline here 4 essential settings in Preferences (Window and Link Styles, Mail and News, Applications and Directories, Helper Applications). For information on other settings, please refer to the 'Netscape Installation & Config' document on SLAC Macintosh Public Disk or the relevant document for your site. Additional information can be gotten from sources cited in the References section.

1) **Window and Link Styles**

- You set the page you want Netscape to start up with in the Home Page Location box.
- Clicking on 'OK' will save your Preferences changes and quit this dialog box.
2) Mail and News

Your e-mail address and related information is used by Netscape for many transactions, including:
- anonymous FTP
- sending out e-mail
- filling out forms

You specify the settings in this window.

- For SLAC users, in the Mail (SMTP) Server box, enter smtpserv.slac.stanford.edu after erasing the old text in the box. For non-SLAC users, please check with your system administrators.
- In the Your Name box, enter your favorite name! In the Your Email box, enter your electronic mail address (e.g. xyz@slac.stanford.edu). In the Organization box, enter SLAC or your home institution. You can leave the default values for the rest of the Mail settings.
- For SLAC users, in the News (NNTP) Server box, enter nntp.slac.stanford.edu after erasing the old text in the box. You can leave the default values for the rest of the News settings. For non-SLAC users, please check with your system administrators.
- Clicking on 'OK' will save your Preferences changes and quit this window.
3) Applications & Directories

- For SLAC users, you can leave the default values for the Supporting Applications settings.
- In Directories, set the Temporary Directory to a folder you want files downloaded from Netscape to go to. In this example, I have created a folder named Web Download. Click on the Browse... button next to Temporary Directory. A navigation dialog box will pop up, and you need to navigate to the folder you want and click once to select it. For this example, click on the Select Web Download button that appears under the scrolling list.
- Click now on 'OK' to leave the Preferences setup.

4) Helper Applications

Netscape is designed to use Helper Applications to view different multimedia files you retrieve. There are several Helper Applications available on the SLAC Macintosh Public Disk.

<table>
<thead>
<tr>
<th>Program</th>
<th>Handle Multimedia Type</th>
<th>Handle Extensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEGView</td>
<td>images, MPEG movies, sounds, pdf files (written by Adobe Acrobat)</td>
<td>tiff, jpeg, gif, mpeg, aif, au, aiff, snd</td>
</tr>
<tr>
<td>Sparkle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound Machine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat Reader</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MacGhostScript</td>
<td>postscript</td>
<td>ps</td>
</tr>
<tr>
<td></td>
<td>(this is still a test version, see page 14)</td>
<td></td>
</tr>
</tbody>
</table>
The **Helper Applications** dialog box tells Netscape you have these Helper Applications. It

1) identifies the different file types Netscape encounters on the Web by associating a file type with a file extension
2) tells Netscape the correct Helper Application to pass the file to after it identifies the file

---

**Specifying the name of the Helper Applications**

- Select the file type a Helper Application views from the **Mime type** and **Subtype** scroll list. (Mime refers to the method of determining a file type from a file's extension.)

Here the example is given for MacBinary program which is

- **Mime type:** application
- **Subtype:** x-macbinary
- **Extensions:** bin

(Mime type is the general category of the file – text, image, video, audio, application. Subtypes are the names of the file formats. Examples of file extensions are on page 18)

- Specify the file type's Helper Application by clicking on the **Browse...** button and selecting the Helper Application to be run from the dialog box.

- **Select the Action** to be performed when Netscape encounters this file type.
Adding or changing file extensions

- Select the file type from the *Mime type* list. Add the new extension after the existing extensions in the Extensions field (separate the extensions with a comma).

Adding a new file type to the Mime list

- Click the New button to get the Create New Mime Type dialog box.
  Type in the new Mime Type and Mime subtype.
  Refer to the previous example on page 19.

- Select the *Action* to be performed when Netscape encounters this file type.

References

- ‘Using Netscape-The User-Friendly Reference’
  by Warren Ernst from QUE publications is an excellent guide.

- ‘The Netscape Online Handbook’ is on-line help you can access on WWW


- ‘HTML Sourcebook-A Complete Guide to HTML’
  by Ian S. Graham from John Wiley & Sons, Inc. publications is a good guide for the
  Hypertext Markup Language, creating Home Pages, Common Gateway Interface (CGI
  scripts), etc.

Please contact the SLAC Computer Center Help Desk (415-926-2406, e-mail
SERVDESK@SLAC.Stanford.EDU) or your local computer system administrators for help in
using Netscape and other Web Browsers. Please e-mail ACHAN@SLAC.Stanford.EDU for
questions regarding this short guide.